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This chapter contains the following sections that describe basic procedures for managing the
performance of the Cisco Media Gateway Controller (MGC) Node Manager (MNM) node:
•

Overview of Performance Management Features, page 7-2

•

Monitoring Network Performance, page 7-4
– Task 1. Setting Performance Polling Frequencies, page 7-5
– Task 2. Starting Polling On a Network Element, page 7-6
– Task 3. Viewing Performance Data, page 7-7
– Exporting the Currently Displayed Performance Data, page 7-16
– Printing a Performance File, page 7-16

•

Selecting What To Monitor, page 7-16, provides some general guidelines and examples

For reference information on the performance measurements collected by Cisco MNM, see Appendix B,
“Performance Measurements Reference.”
This chapter also describes the procedures that may be used by system administrators:

Note

•

Filtering Measurements Collected by Cisco MNM, page 7-18

•

Changing Performance Thresholds, page 7-18

•

Exporting Bulk Performance Data, page 7-19

•

Changing How Performance Data Is Archived, page 7-20

You can set performance thresholds for various measurements. When performance falls below the
threshold level, Cisco MNM notifies you with a threshold crossing alert (TCA). See Chapter 6,
“Managing Faults with Cisco MNM” for details on setting and managing performance thresholds.
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Overview of Performance Management Features
An important component of efficient network management is the ability to receive performance
information on a large network of many devices to provide an overall view of the your network’s
functioning. You can then proactively manage your network elements by analyzing the performance
data. This information can be used to evaluate the performance of specific equipment, assess the
requirements for upgrades or software downloads, and identify problem areas in the network.
Performance statistics also provide a summary view of the performance of network elements. These
statistics help you determine the degree to which the network is meeting assigned service levels.
Cisco MNM provides performance management features to collect, display, and store performance data.
You can:
•

Collect selected performance attributes on any Cisco PGW 2200 Softswitch node device or group
of devices at specific intervals

•

Drill down in the Map Viewer from the network level to the device level to view individual device
statistics

•

In the Performance Manager, you can:
– View performance data for selected time periods
– Depending on the device, view performance data in line graph, bar chart, or table format
– Export the displayed performance data to a flat file
– Print performance data

The system administrator can:

Note

•

Filter measurements collected by Cisco MNM

•

Change performance thresholds

•

Export bulk performance data

•

Change how performance data is archived

Performance data related to trunk groups and SS7 can only be viewed if the BAMS is deployed.

What Is Monitored
Most devices in the Cisco PGW 2200 Softswitch node have a set of attributes whose performance
statistics can be monitored. Depending on the type of device, performance data is collected in one of two
ways:

Note

•

Cisco MNM collects performance data from the network devices by polling SNMP data. This is
called performance polling.

•

Cisco MNM retrieves performance data for the active Cisco PGW 2200 Softswitch host signaling
and trunking components (also known as the Cisco PGW 2200 Softswitch host configuration) by
retrieving flat files generated by the host and the BAMS. This is called configuration polling.

SNMP data can be viewed only in raw, not summarized, form.
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Table 7-1 lists the Cisco MNM-managed elements, devices and subcomponents for which performance
data is collected. Of these, most can have data displayed in either raw or summary form (column 2). For
those with SNMP data, only raw data can be viewed (column 3). Some elements are supported only by
Cisco PGW 2200 Softswitch Release 9, as indicated.

Tip

Specific performance measurements are in Appendix B, “Performance Measurements Reference.” If you
are viewing the document online, you can click the page number in the first column to go to the
performance measurements list for that element type.

Note

See Chapter 1, “Overview of Cisco Media Gateway Controller Node Manager,” “How Cisco MNM
Models the Network” section on page 1-9 for information about supported elements.
Table 7-1

Elements with Performance Data

Element Types with Performance Data

Raw or Summary Data Raw Data Only

Cisco BAMS (Appendix B, page 7)

X

—

Cisco PGW 2200 Softswitch host (Appendix B, page 4)

X

—

Cisco ITP-L (Appendix B, page 8)

X

—

Cisco LAN switch (Appendix B, page 8)

X

—

Cisco 2900 LAN switch port (Appendix B, page 8)

—

X

Cisco 5500 and 6509 LAN switch ports

—

X

HSI Adjunct, BAMS and Cisco PGW 2200 Softswitch
system components (Appendix B, page 11)

—

—

Fixed disk (Appendix B, page 11)

—

X

RAM (Appendix B, page 12)

—

X

Processor (Appendix B, page 11)

—

X

Virtual memory (Appendix B, page 12)

—

X

Interfaces (Appendix B, page 10)

—

—

Serial (Appendix B, page 10)

—

X

TDM (ITP-L only)

—

X

Ethernet (Appendix B, page 10)

—

X

Generic (Appendix B, page 10)

—

X

Signaling & Trunk Group Components (Appendix B, page 12) —

—

Adjacent point code

X

—

C7 IP link

X

—

Network card or adapter

X

—

CAS path (Release 9)

X

—

Point code

X

—

EISUP path

X

—

Ethernet interface

X

—
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Table 7-1

Elements with Performance Data (continued)

Element Types with Performance Data

Note

Raw or Summary Data Raw Data Only

FAS path

X

—

IP FAS path

X

—

IP link

X

—

Linkset

X

—

MGCP path

X

—

NAS path

X

—

SGCP path

X

—

SIP link (Release 9)

X

—

SIP path (Release 9)

X

—

TDM link

X

—

Trunk group

X

—

Cisco IP Transfer Point LinkExtender (ITP-L) is the new name for Cisco Signaling Link Terminal (SLT).
Over time, ITP-L will replace SLT in publications and the product.
Cisco MNM does not collect performance data for the following device types:
•

Loopback interface for Cisco PGW 2200 Softswitch, HSI server, or BAMS

•

Cisco ITP-L SS7 MTP2 Channels

•

Signaling components:
– D-channel backup
– TCAP IP path
– SS route
– SS7 subsystem
– Signaling Gateway and Signaling Gateway Pair
– SS7 signal path to Signaling Gateway Pair
– SS7 Signaling Gateway Subsystem

Monitoring Network Performance
Monitoring network performance involves three basic tasks:
Task 1. Select the devices to poll and the polling frequency for each one.
Task 2. Start polling.
Task 3. View performance data using the Performance Manager.
See the following sections for more information.
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Task 1. Setting Performance Polling Frequencies
You can specify a different polling frequency for each device type. All devices of that type and all
components of such devices will have the same polling frequency. For example, if you set a 10 minute
polling frequency for one Cisco ITP-L in the network, the frequency is applied to all Cisco ITP-Ls in the
network and to all monitored elements on the Cisco ITP-L, such as the TDM interfaces.
For the Cisco ITP-L and Cisco LAN switch, the polling frequency is set at the device level. All
components of the device have the same polling frequency as the parent device. For example, setting a
frequency of every 10 minutes for a Cisco ITP-L also polls its TDM interfaces every 10 minutes.

Note

The polling frequency you set in the Cisco PGW 2200 Softswitch host determines how often the host
generates flat files that contain performance data on signaling and trunk group components. Do not set
the polling frequency in Cisco MNM to be less (more frequent) than the Cisco PGW 2200 Softswitch
host polling frequency, but you can set a greater interval (less frequent) in Cisco MNM if you do not
want to process all the performance files generated. For example, you can set
Cisco PGW 2200 Softswitch host performance data collection to every 20 minutes.
Default polling frequencies are
•

Every 5 minutes for performance polling

•

Every 15 minutes for configuration polling (signaling and trunking components)

For SSH-enabled components (defined as the Security Policy at deployment or in the Accounts dialog
box), polling uses SSH.

Note

Both the active and standby Cisco PGW 2200 Softswitch hosts should be polled to prevent loss of
performance data if a Cisco PGW 2200 Softswitch host failover occurs.
Use the following procedure to set or change a polling frequency:

Step 1

In the Map Viewer window, right-click the desired device, and choose States.

Note

For the Cisco PGW 2200 Softswitch host, including Cisco PGW 2200 Softswitch node
signaling or trunking components, select the Cisco PGW 2200 Softswitch Host object.

Note

If the States option is not available, select the parent device.

The States dialog box opens.
Step 2

Set the desired polling frequency:
•

For any of the Cisco PGW 2200 Softswitch node devices, including the
Cisco PGW 2200 Softswitch host, HSI server, and the BAMS system components, set the
Performance Polling frequency.
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Note

Step 3

•

For the Cisco PGW 2200 Softswitch node signaling and trunking components, set the Configuration
Polling frequency.

•

Select the minutes or hours option from the pull-down menu. For all devices and types of polling,
the minimum frequency is 1 minute and the maximum is 24 hours.

•

Setting the auto-start polling option ensures that if a new device of this type is deployed, it begins
polling immediately without you having to turn polling on. See Chapter 5, “Deploying Your
Network in Cisco MNM” for more information.

•

For information on Auto-Discovery polling, see Chapter 5, “Deploying Your Network in
Cisco MNM,” “Synchronizing the Cisco MNM with Device Changes” section on page 5-20. Status
polling checks the device status, such as up, down, active, or standby, as shown on the Status tab of
the Properties dialog box for the device. For more information, see Chapter 6, “Managing Faults
with Cisco MNM,” “Task 1. Adjusting Status Polling Settings If Needed” section on page 6-3.

Go to “Task 2. Starting Polling On a Network Element” to start polling at the selected frequency.

Task 2. Starting Polling On a Network Element
You can enable performance polling on an individual network element (a device or a component of a
device) or on all the elements in a Cisco PGW 2200 Softswitch node. For polling to be enabled, the
parent device must be in the normal (commissioned) state. Enabling polling places the device into the
polling state.

Note

For information on commissioning and decommissioning devices, see Chapter 6, “Managing Faults with
Cisco MNM,” “Commissioning, Decommissioning, and Rediscovering Devices” section on page 6-23.
For the Cisco ITP-L and Cisco LAN switch, polling is turned on or off at the device level. Polling is
enabled or disabled for all components of the device along with the parent device. For example, starting
polling on a Cisco ITP-L starts polling on its TDM interfaces.
Use the following procedure to start polling on one or more network elements:

Step 1

In the Map Viewer, do one of the following:
•

For an individual element, right-click the desired object, and choose States.

•

For all the devices in a Cisco PGW 2200 Softswitch node, under MGC-Node-View, right- click the
desired node, and select MGC Node States.

The States dialog box opens.

Note

•

If the States option is not available, select the parent device.

•

For the Cisco PGW 2200 Softswitch host, including Cisco PGW 2200 Softswitch node signaling or
trunking components, select the Cisco PGW 2200 Softswitch host object.
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Step 2

Click Start Polling. You are prompted to confirm the operation.

Step 3

Click Yes.
If you want to stop performance polling later, access this dialog again, and click Stop Polling.
During polling, a polling symbol appears just above the object icon in the Map Viewer, as shown in
Figure 7-1.
Figure 7-1

Note

Step 4

Map Viewer Icon of ITP-L TDM Interface in Polling State

See Chapter 3, “Getting Started with Cisco MNM,” “Viewing Cisco MNM Status Information” section
on page 3-9 for more on status symbols.

Go to the “Task 3. Viewing Performance Data” section on page 7-7.

Task 3. Viewing Performance Data
Once you set the polling interval and start performance polling for an element, you can view the data
collected in the Performance Manager.
From the Performance Manager window, you can:

Note

•

Identify and view data for all monitored attributes on a selected managed element.

•

Identify and modify the summary intervals and rules, if any, configured for selected monitored
attributes.

•

View historical performance data over a requested period of time (in tabular or graphical format).

•

Print performance data to a printer or file.

•

Export the displayed performance data to a file.

Because of constraints imposed by the BAMS, the trunk group performance data is not reported in real
time and might be delayed for up to 45 minutes. For details, refer to the BAMS documentation.
Use the following procedure to view performance data:

Step 1

Note

In the Map Viewer window, right-click the desired object, and choose Tools > Performance Manager.

•

You can also open the Performance Manager by right-clicking an object in the Event Browser or the
Object Manager.
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•

If the Performance Manager option is not available, performance data is not collected for the
selected element. Try navigating down a level to a component that may be monitored.

The Performance Manager window opens. The window title bar shows the name of the selected object.
For details on the window, see the “About the Performance Manager Window” section on page 7-10.
Step 2

From the Monitored Attributes list, select the attribute whose data you want to view.

Note

Select a range of multiple attributes in a list by holding down the Shift key and selecting
attributes in the list. Select multiple individual attributes by holding down the Ctrl key and
clicking individual items. The information for all selected attributes is shown in the Table
Display, with a column for each attribute. Only the first selected attribute is shown in the line
chart or bar chart.

Step 3

(Optional) Modify the Time Period settings to display data collected between a specified start and end
date.

Step 4

(Optional) By default, data is presented in raw (unsummarized) form. To view summary data instead:
•

Note

•
Step 5

From the Interval pull-down menu, select a summary interval. The summary interval is the period
of time over which the summary rule is applied. Options vary according to the attribute selected.

If polling has begun during the last day, selecting an interval of a day results in no data being
displayed.
(If a summary interval is selected) From the Rule drop-down menu, select the summary rule to be
used. The default summary rule is one day (24 hours).

Click Refresh to display data for the selected attribute.

Note

The Refresh button is dimmed when there is nothing to refresh. Refresh is available when Now
is selected or when any criteria has changed and you have moved the cursor away from the
changed value by pressing the Tab key or by clicking the mouse.

Step 6

Click the Line Chart, Bar Chart (if available), or Table Display tab to view your data in the desired
format.

Step 7

For details on reading and manipulating the Performance Manager display, go to the “About the
Performance Manager Window” section on page 7-10

.

Updating the Performance Manager Display
To update the data display after changing the time period, summary interval, View menu options, or
attribute, click Refresh.

Note

If you have stopped polling on a device, to update the data you must start polling again, and then click
Refresh.
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Performance Manager Usage Examples
Here are two examples using performace manager to view host performance data like UDP/TCP related
information and view Cisco PGW 2200 Softswitch node performance data like CALL: SuccCall
TOT/CALL: FailCall TOT.
To view host performance data like UDP/TCP information, right-click the host whose data you want to
view in Host-View of Map Viewer. Select Tool>Performance Manager and select the attribute you want
to view in the Monitored Attributes. Adjust the Time Period and Summary if needed and click Refresh.
UDP In Datagrams information displays in the window like the one shown in Figure 7-2.
Figure 7-2

UDP In Datagrams Display in Performance Manager Window

To view Cisco PGW 2200 Softswitch node performance data like call-related information, right-click
the Cisco PGW 2200 Softswitch node whose data you want to view in MGC-Node-View of Map Viewer.
Select Tool>Performance Manager and select the attribute you want to view in the Monitored Attributes.
Adjust the Time Period and Summary if needed and click Refresh.
CALL: SuccCall TOT information displays in the window like the one shown in Figure 7-3.
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Figure 7-3

CALL: SuccCall TOT Display in Performance Manager Window

About the Performance Manager Window
When you open the Performance Manager, a window displays like the one shown in Figure 7-4.
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Figure 7-4

Performance Manager Window

Monitored Attributes
The Monitored Attributes list displays the performance counters for the selected device. Initially, the
first attribute in the list is selected. The performance information for the selected attribute is displayed
in the right panel. To view the performance of another attribute, select the attribute, and click Refresh.
You can select multiple attributes by pressing Ctrl and clicking individual attributes.
See Appendix B, “Performance Measurements Reference,” for details on attributes monitored for the
various Cisco PGW 2200 Softswitch node devices.

Performance Information Display
Line charts, bar charts, and tables: You can view the data for most attributes in a line chart or table.
Summarized data can also be viewed in a bar chart.
Line charts plot one single attribute at a time (the attribute currently selected in the Monitored Attributes
list). Time is plotted on the horizontal axis, and the count is plotted on the vertical axis (see Figure 7-5).
Bar charts show comparisons of summarized data over time, such as totals for week 1 and totals for week
2.
Tables can display data for multiple attributes. The data for each attribute is shown in its own column.
Each cell in the column displays the value of one data interval (see Figure 7-6).
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Sample Line Chart

Figure 7-6

Sample Table

44835

Figure 7-5

Color-code key: As the key at the top of the display shows, the colored dots (in line charts) or cells (in
tables) indicate these events in data collection:
•

Green indicates when performance polling started.

•

Yellow indicates that a poll for an attribute was missed.

•

Red indicates when performance polling stopped.

View options: In a line or bar chart, the View menu allows you to display additional information on the
chart by selecting:

Tip

•

Values—Plots the values of the samples collected

•

Points—Plots the time that the samples were collected, marking each data point with a black dot

If values are displayed on a chart, zooming in one or two levels helps make the values readable.

Cisco Media Gateway Controller Node Manager User Guide

7-12

OL-18339-03

Chapter 7

Managing the Performance of Cisco MNM Devices
Monitoring Network Performance

Time period start and end
•

Start Date—The date to start displaying data (in the format mm/dd/yyyy).

•

End Date—The date to stop displaying data. Alternatively, for End Date, you can select the Now
check box to view the data from the selected start date to the present date and time.

Note

The Now option is dynamic. Selecting Now at 10:30 p.m. displays all available data between the
start date and time and 10:30 p.m. Selecting Now at 11:00 p.m. displays all data through 11:00
p.m. Use Now to view the latest data.

•

Start Time—The time from which you want to display data. Use 24 hour format.

•

End Time—The time to which you want to display data. If you selected Now for End Date, you do
not need to specify an End Time.

Note

The default start date and time is the current date and time minus 8 hours. The default end date
and time is the time when you open the Performance Manager.

Summary
By default, data is displayed in raw (unsummarized) form. For most network elements, you can also view
summarized data. Where you want to inspect performance over time, a summary view is typically more
meaningful. For example, you may want to view the Errored Packets for a device over a six-month
interval. If the data was displayed in a table or graph at the rate at which it was sampled, this could be
tens of thousands of value summaries of the data. Managing the network is facilitated by being able to
summarize data in hourly, daily, or weekly intervals

Note

Data for some network elements can be viewed only in raw, not summarized, form. See Table 7-1 on
page 7-3 for a list. When raw is selected, the Bar Chart view is not available, and the Summary Rule
option is dimmed.
Summary interval: Select raw or, for a summary, the desired interval:
•

Hourly summaries are generated on the hour.

•

Daily summaries are generated at midnight.

•

Weekly summaries are generated at midnight on Sundays (that is, the end of Sundays).

For example, if polling starts at 9:30 and hourly summaries are to be generated, the first full hour of data
is between 10:00 and 11:00, so at 11:00, the first hourly summary is generated and given a timestamp of
10:00. The same pattern is followed for all summaries (daily, weekly, or user-defined). This pattern
standardizes summary intervals so that all attribute summaries have the same timestamps.

Note

In the above example, data generated between 9:30 and 10:00 is ignored An hourly summary for 9:00 to
10:00 would be misleading, because it would have been generated using only half the usual number of
values.
Summary rule: If you selected a summary interval, choose the way you want the data summarized:
•

Total—Adds all values gathered in the summary period
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•

Average—Takes the average of all values gathered in the summary period

•

Min—Presents the lowest value received over the summary period

•

Max—Presents the highest value received over the summary period

•

Logical OR—Displays either 1 or 0. This is typically used for status flags. Some attributes may have
only two potential values (such as, true or false, yes or no, 1 or 0). When summaries are generated
from values such as these, and the logical OR rule is used, the summarized value is 1 if any value in
the summary interval is 1. If all values in the summary interval are 0, then the summarized value is 0.

Refresh button
Click Refresh to update the display with the most current data or to update the display after changing
the time period, summary interval, View menu option, or the attribute selected.
The Refresh button is dimmed when there is nothing to refresh. Refresh is available when Now is
selected or when any criteria has changed, and you have moved the cursor away from the changed value
by pressing the Tab key or by clicking the mouse.

Navigating in the Performance Manager
You can zoom in, zoom out, and move around the displayed charts by using the keys and mouse buttons
described in Table 7-2.
Table 7-2

Chart Viewing Actions

Press

Action

Shift-click

Selects multiple blocks of attributes in a list.

Ctrl-click

Selects multiple attributes in different areas of a list.

Up arrow key

Scrolls up the Table display.

Down arrow key Scrolls down the Table display.
Left mouse
button

Clicking and dragging with the left mouse button over an area
zooms in on that section of the chart. You cannot zoom in on
a chart that has a scroll bar.

Middle mouse
button

Takes the view back one zoom level after zooming in using
the left mouse button.

Use the following procedure to zoom in or out in a chart:
Step 1

Click and drag the left mouse button to select the area you want to zoom, as shown in Figure 7-7.
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Figure 7-7

Selecting an Area to Zoom

Figure 7-8 shows the results of zooming in two levels and turning on the view of data values.
Figure 7-8

Step 2

A Zoomed Line Chart with Values On

To return to the previous zoom level, click the middle mouse button.

Cisco Media Gateway Controller Node Manager User Guide
OL-18339-03

7-15

Chapter 7

Managing the Performance of Cisco MNM Devices

Selecting What To Monitor

Exporting the Currently Displayed Performance Data
You can export performance data in two ways:
•

Using the File command in the Performance Manager, you can create an ASCII file containing the
performance data currently displayed (data for the selected object and specified time period). This
procedure is covered in this section.

•

Using the historyAdmin export command, you or a northbound system can generate files that
contain bulk performance data for all objects in the network over a given number of days. See the
“Exporting Bulk Performance Data” section on page 7-19.

The data file can be brought into another application for analysis.
Use the following procedure to create a file containing the currently displayed data:
Step 1

Open Performance Manager on the object for which you want to export performance data.

Step 2

Select File > Export To File or click

Step 3

Enter the name and path for the file, and click Apply. A file is created containing the currently displayed
performance data.

Note

. The File Chooser dialog box opens.

By default, the file is saved in the <CEMF_ROOT>/bin/performanceMgr.sysmgr folder. Select
a different path to save the file to a different location.

Printing a Performance File
You can print performance statistics from the Performance Manager, either as a chart or as a table. A
chart prints out the information that can be seen in the window. A table prints out all performance
statistics in plain text format.
The output is printed by the default printer set up on your network.
Use the following steps to print a performance file:
Step 1

Open the Performance Manager and select the desired attribute or attributes.

Step 2

From the File menu, select Print. Choose either As Chart or As Table. If you selected multiple
attributes, choose As Table.

Selecting What To Monitor
Intelligent performance management requires that you understand which attributes are the critical
indicators of performance for various network elements and which areas of your particular network are
likely to have the greatest impact on performance for your users.
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Before using the Performance Manager, identify what you want to know so that you can focus on a
manageable set of indicators. As you gain experience with the Cisco PGW 2200 Softswitch node and
with Cisco MNM, you can add to or refine your lists of monitored attributes for key performance factors.
To help you get started, this section presents examples of attributes you might monitor for several
network elements. These lists are offered as examples only and are not intended as recommendations.

Note

The measurements list presented here is not a complete list of counters for monitoring performance. For
comprehensive performance, other attributes should be monitored.

SS7 Monitoring Example
See the example attributes in Table 7-3 for information on monitoring SS7 performance.
Table 7-3

SS7 Monitored Attributes (An Example)

Network
Element

Measurement Group

C7 IP Link

C7Link (SS7 Link statistics) C7LNK: DUR UNAVAIL

Counter

Description
Duration unavailable
(in seconds)

C7LNK: MSU DROP-CONG Total messages
dropped due to
congestion
Point Code

Point Code

C7SP (SS7 Signal Path
statistics)

ISUP

C7SP: SP DUR UNAVAIL

Duration unavailable

C7SP: XMIT MSU
DROP/RTE

Total number of
messages dropped due
to routing failure

ISUP:XMIT CGB TOT

Circuit group blocked
msgs transmitted

ISUP:RCV CGB TOT

Circuit group blocked
msgs received

ISUP:XMIT CGU TOT

Circuit group
unblocked msgs
transmitted

ISUP:RCV CGU TOT

Circuit group
unblocked msgs
received

If you are using Blacklist features, also monitor the following:
Signaling
Service

SP (Signaling Service
statistics)

SP:Blacklist Call Ctr

Number of blacklist
calls

System Administration for Performance Management
This section is designed for system administrators. It describes the following procedures related to
administration of Cisco MNM performance management:
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Note

•

Filtering Measurements Collected by Cisco MNM, page 7-18

•

Changing Performance Thresholds, page 7-18

•

Exporting Bulk Performance Data, page 7-19

•

Changing How Performance Data Is Archived, page 7-20

For more information on system administration related to performance management, see “Performance
Data Storage” in the Cisco Element Management Framework Installation and Administration Guide at
http://www.cisco.com/en/US/docs/net_mgmt/element_manager_system/3.2/installation/guide
/install_1.html.

Filtering Measurements Collected by Cisco MNM
Cisco MNM predefines the performance measurements collected on SNMP-managed devices and
processes whatever data is available. For measurements on signaling and trunking components
(Cisco PGW 2200 Softswitch host configuration), the Cisco PGW 2200 Softswitch host writes out flat
files containing the data. You can use measurement filters to collect a subset of configuration
measurements.
Use the following procedure to filter measurements for SNMP-managed elements:
Step 1

Edit the measFilters file in <CEMF_ROOT>/config/hostController. This file, read at startup,
determines what measurements are retrieved from the Cisco PGW 2200 Softswitch-generated flat files.
The following illustrates the format of the measurement filter files:
Measurement Name, *|Component Name
Where the variables are those defined in Table 7-4.

Step 2

Insert a pound sign (#) at the beginning of the line you want to comment out.

Step 3

For the change to take effect, stop and restart Cisco EMF.
Table 7-4

Cisco MNM Measurement Filters

Parameter

Description

Measurement name

Any measurement specified in the
Cisco PGW 2200 Softswitch host measCats.dat file.

Component name

Any MML component specified in the
Cisco PGW 2200 Softswitch host components.dat file.
An asterisk (*) matches all components.

Changing Performance Thresholds
If you want to check or change performance thresholds on the Cisco PGW 2200 Softswitch host, HSI
server, and the BAMS, you must use MML to set the thresholds on the device itself.
Use the following procedure to access the device from Cisco MNM:
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Step 1

In the Map Viewer window, right-click the device and choose Tools > Connection Service.
A Telnet or ssh window opens, depending on your security policy.

Step 2

Change the desired performance thresholds.

Step 3

For information on using MML commands with the Cisco PGW 2200 Softswitch host, refer to the
Cisco PGW 2200 Softswitch Release 9 MML Command Reference.
For information on the BAMS, see “Setting up Disk Monitoring Thresholds at
http://www.cisco.com/en/US/docs/voice_ip_comm/pgw/bams/3.30/guide/330ch2.html

Exporting Bulk Performance Data
Cisco MNM allows exporting performance data in two ways:
•

Using the historyAdmin export command, you or a northbound system can generate files that
contain bulk performance data for all objects in the network over a given number of days.
Instructions are provided in this section.

•

Using the File command in the Performance Manager, you can create an ASCII file that contains the
performance data currently displayed (data for the selected object and specified time period). See
the “Exporting the Currently Displayed Performance Data” section on page 7-16.

The data file can be brought into another application for analysis.

Tip

Because performance data is not archived indefinitely, you may want to export data before it is deleted
from the archive database. See the “Changing How Performance Data Is Archived” section on page 7-20
for details on archiving.
Use the following procedure to export data about the entire monitored network:

Step 1

(Optional) Change the export settings:
•

Step 2

Modify the file <CEMF_ROOT>/bin/historyAdmin to set the desired starting and ending date and
time, summary interval, and rule if appropriate.

Create the file:
•

Enter the cemf shell:
/<CEMF_ROOT>/bin/cemf shell

The message “Running bin/sh” appears and the Cisco MNM command prompt appears:
CEMF Manager >

Note

•

At the command prompt, enter the command /opt/cemf/bin/historyAdmin export.

•

export <filename> <separator> <max file size (KB)> [all | <number_of_days>] <criteria name> ...
(where filename is the name of the file to be created).

•

For a list of all available criteria names, enter the following command:
<CEMF_ROOT>/bin/historyAdmin list.
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•

A northbound system can use Telnet or another facility to access the Cisco MNM server.

The data is exported in the following format:
Object:<object path>
Object class:<object path>
Attribute: <attribute name>
Summary rule:<rule>
Summary interval: Raw | <summary interval>
<date> <time> <valueType> <value>
<date> <time> <valueType> <value>
...
Data exported: <current date/time>

A sample file looks like:
> historyAdmin export dumpFile TAB 10 all criteria1
Object: exampleView:/site_1/bay_1/agent_1/rack_1/linecard_2/port_2
Object Class: testPort
Attribute: LocalDB:TEST.dtIndex1
Summary interval: Raw
09 Jun 1999 11:50:03 Polled 10
09 Jun 1999 11:50:23 Polled 10
09 Jun 1999 11:50:43 Polled 15
09 Jun 1999 11:51:03 Missed <no value>
09 Jun 1999 11:51:23 Polled 20
09 Jun 1999 11:51:43 Polled 20
09 Jun 1999 11:52:03 Polled 0
09 Jun 1999 11:52:23 Polled 5
09 Jun 1999 11:52:43 Polled 0
09 Jun 1999 11:53:03 Polled 10
Data exported: Sun Jun 27 17:17:35 1999

Changing How Performance Data Is Archived
Cisco MNM stores performance data in a database that is periodically purged so that it does not grow
indefinitely. You can change how long data is stored before purging and specify roll-up rules and other
actions that should be taken on performance data after a set length of time.
The attributeHistoryServer.ini file, described in Table 7-5, controls the behavior of the performance
purging mechanism. These are the default settings:
minValueCount = 50
maxValueCount = 1000
minRawDataAge = 60
These values can be modified using the historyAdmin utility. Because the settings have a significant
effect on database size, performance, and overall disk requirements, take care when changing these
parameters.
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Table 7-5

attributeHistoryServer.ini file Attributes

Parameter

Description

minValueCount

Specifies the minimum number of values for each sample. Data is never removed
from a sample if doing so would result in that sample having fewer than the
minimum number of values. This value is set to 50 on a standard Cisco EMF
installation.

minRawDataAge Specifies the minimum age of raw data (in seconds) that must be kept. Raw data
younger than this age is never removed. This value is set to 60 on a standard
Cisco EMF installation. For example, if the system has just received 100 changes
to an attribute in the 40 seconds preceding a purge, the last 100 values are kept,
and not just the last 50.
maxValueCount

Note

Specifies the maximum number of values to be kept for each sample. Whenever
this number is reached for a sample, values are removed until either of the first
two settings would be breached if any more were removed. This value is set to
1000 on a standard Cisco EMF installation.

In some cases, these settings may conflict with history-storage-criteria summary intervals. For example,
if the history storage criteria specifies that only daily summaries are to be generated, but the purging
criteria specifies that one full day’s worth of raw data is never available, then the daily summaries could
not be generated if the purge settings were followed. In such cases, data is not purged until summaries
that depend on that data have been generated.
For information on configuring how alarms are stored and deleted, see the Chapter 6, “Managing Faults
with Cisco MNM,” “Specifying the Length of Time Alarms Are Stored” section on page 6-27.
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